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Section 1

Introduction

Welcome to the megaAVR® Starter kit.

This system incorporates an applications board and in-system programming hardware
key, for programming AVR devices in your application. Be sure to check the
README.TXT file included with the software for installation information.

1.1 Device Support The system software currently has support for the following devices.

n ATmega603

n ATmega603L

n ATmega103

n ATmega103L

Software upgrades for new devices will be available in the AVR section of the Atmel
website, which is located at http://www.atmel.com.
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Section 2

Getting Started

2.1 Unpacking the 
System

Contents of box:

n Evaluation Board

n Disk set consisting of AVR ISP software and STK300 Application Builder

n In-System Programming (ISP) Dongle

n ISP Ribbon Cable

2.2 System 
Requirements

The minimum hardware and software requirements are:

n 80386 Processor or Above

n 1MB Ram

n 1MB Free Hard Disk Space

n Windows 3.1 or Windows 95
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Section 3

Connecting The System

A Power Supply is required with a standard 2.1mm barrel connector. It can be AC 7 -
12V or DC 9 - 15V. The connector is inserted into the power connection socket as
shown, above.

The programming lead supplied is fitted into the Dongle case and the other end is
inserted into the programming interface on the board as shown.

The Dongle case is connected to one of the printer ports on the PC. If this is not LPT1,
then you will need to change the printer port setting in the software—see software sec-
tion for details.

PLUG HEADER ON LEAD 
INTO PROGRAMMING 
INTERFACE - KEY WAY 
GIVES ORIENTATION

CONNECT LEAD
SUPPLIED TO DONGLE

AND INSERT IN
PC PRINTER PORT

POWER SUPPLY
9 - 15V DC
7 - 12V AC

ON-OFF SWITCH

RS 232 CONNECTOR
NOT USED FOR
PROGRAMMING

POWER CONNECTOR
5.5/2.1 BARREL
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Section 4

Hardware Description

The main features of the board are shown in the diagram below.

Note: There are a number of jumpers on the board which are used to select different 
operations and voltages. The default jumper settings are for programming oper-
ations at 5V JP1 Closed, with brown-out also set to 5V JP2 Open. 
To carry out other operations, some jumpers may have to be removed—refer to 
the relevant section for details. A full list of the jumpers and links are given in the 
table below.
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4.1 Jumpers, Links 
and their 
Functions 

4.2 External 
Connections 

All Ports are brought out to edge of board on to headers. Each header has a VCC and
Ground pin for power supply to external circuits. Port F is the Analog input port and is on
a header marked Analog. There is an extra six-pin header for miscellaneous functions—
Read, Write, ALE, Reset, Ground and VCC.

See sections on Using External Connections and Using Analog Functions for details.

Jumper Function Open Closed Default

JP1 Voltage select 5V 3.3V Open

JP2 Brown out select 2.9V 4.5V Closed

PE0 RS232 RXD Port E.0 RXD Port E.0

PE1 RS232 TXD Port E.1 TXD Port E.1

Port B LEDs LEDs Disabled LEDs Enabled Closed

Port D Switches Switches Disabled Switches Enabled Closed

LK1
Analogue 
Reference

if LK1 cut then 
EXTERNAL REF 
from header

ONBOARD POT Closed

CUT Under 
Board

LCD Contrast
If Cut, add 
extra resistor

Contrast Pot Closed
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Section 5

Installing The Software

5.1 Windows 95 To install the software, insert the supplied disk or CDROM into your computer and per-
form the following steps:

1. Click on your Start button.

2. Select Settings.

3. Select Control Panel.

4. Choose Add/Remove Programs.

5. Click the Install button.

6. Follow On-Screen prompts.

The software will then be installed onto your computer and an Icon will be added to your
start menu. 

5.2 Windows 3.1 Choose RUN from Program Manager, and enter A:\SETUP.EXE as the filename. 

Press the OK button and the software installation program will begin.

The software will then be installed onto your computer and an Icon and Program Group
will be added to Program Manager.

Note: On some PCs, especially laptops, programming problems may occur if the 
BIOS Parallel Port settings are set to EPP Version 1.7. If programming prob-
lems do happen, ensure that the Parallel Port settings in your BIOS are set to 
EPP V1.9 not V1.7.

In the unlikely event that you have any problems installing the software or suspect that
you have faulty media, please contact the Atmel Starter Kit hotline:

Telephone Number: (44) 1970 621 049

Fax Number: (44) 1970 621 040

Email: stk300_support@atmel.com
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Section 6

How to Use the Software

The software is fully context sensitive. This means that pressing F1 at any time will bring
up help information about the current option that you have selected.

Please note that the toolbar icons referred to in the text have ToolTip’s, so if you want to
know the function of any particular button, then hold your mouse pointer over the button
in question and its function will be displayed.

n Starting a Project

n In-System Programming (ISP)

n Hardware Requirements

n Projects

n Data Files

n Editing Data

6.1 Projects If you have used a high-end professional development system you will be familiar with
the project concept. Essentially this is a collection of details and data which are man-
aged by the program on your behalf. In the AVR you have both Program Memory and
non-volatile Data Memory EEPROM, with various security and device options. The
project manager keeps this information together for you so you don't have to remember
and reload all the various files every time you use the programmer. 

It will also allow you to store information like the project name, the project identifier and
it has a small notepad for you to store comments about the project. 

So before you can start a programming session you must either open an existing project
or start a new project. You can open a project, or create a new one, by either going to
the Project menu and selecting New or Open, or by using the New Project or Open
Project buttons on the toolbar.

6.2 Files Once a project is open, you can load the files that you need to program into the device.

Files may be loaded by either using the Load command in the File menu or by using the
Open icon on the toolbar.

The program will automatically decode your files whether they are in Intel Hex format,
Atmel Generic, Binary or Motorola S record. The file you choose will be loaded into the
window then it is displayed on the top of the desktop. So if you have the EEPROM Data
Memory window on top then it will load the data into that window.
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Note that the AVR® Assembler which accompanies this program, will produce the cor-
rect files for you ready to load into the buffers. You can save the buffer in Binary, Intel
Hex or Atmel Generic formats, so you can use the buffer for code conversion.

Similarly it will load the data into the Program Memory if that is the window that is on top.
The program will not allow you to load data if the project manager window is on top. To
change which window is on top you can either click your mouse on any part of the win-
dow that is showing, go to the Window menu using Alt W or the mouse, and select the
window of your choice or press CTRL - F6. Note that the loaded data will show up in
blue text where the default (empty) text color is black.

Once your data is loaded you can start your programming session.

6.3 Editing Data Once a project has been started you can either load a data file or you can insert your
own data in Hex or ASCII directly into the Program or EEPROM data windows. 

With a new project the data windows, called buffers, will contain FF in every location.
This is also what a new or erased device will contain. 

You can move around in the current window by using the cursor keys. In order to see
memory further down the window then use the page up and page down keys on the key-
board.

You may change the data at any memory location by clicking on that location and typing
in the hex values you require. Any changes you make will be reflected by the data
changing to green text. The ASCII character of the hex value will be shown alongside
the data window. 

If You wish to edit the buffer in ASCII either click on the right area of the window or press
CTRL - A.

Once you have entered the required data then you can save the contents of the current
window by using either the Save icon on the toolbar or by pressing F2 (on the keyboard)
or by choosing the Save function in the File menu. 

6.4 Programming Read Section on Programming using the Board or Programming In-System before pro-
gramming parts.

Before you can start programming a device you must have a project open on the desk-
top.

6.5 Auto-Program The easiest and quickest method of programming a device is to use the Auto-program
option which is available in either the Program menu or by using the Auto-program icon
on the toolbar. If you use this option then you will be presented with a series of check
boxes to select which features you want to enable or disable during the programming
session. You can enable or disable any of the options by clicking on them or using
Arrow and Space keys. If the option has a check mark next to it then it is enabled, if not
then it is disabled. Note that the default is for all the options to be enabled. Further note
that you should not disable the erase function under normal circumstances.

If the ‘dongle’ is not plugged in to your printer port then you may get an error at this
point. If you get the Dongle not found error and it has been inserted into the printer port
then you should ensure that you have selected the correct printer port.   You can change
the printer port setting by going to the Options menu and choosing Change Printer Port.
Simply choose the correct one for your system. 

The programmer then attempts to read the device signature bytes. If they are not found
because you are using an old version of the device, no device is plugged in, the module
is switched off or the lock bits are set, a message box informs you of this. You have the
option of Abort, Retry or Ignore.
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Auto Program carries out all the steps you have selected.   All these options are avail-
able individually in the Program Menu and some of them also have Speed Buttons on
the toolbar.

n Erase Device

n Program Device

n Verify Device

n Verify EEPROM

n Program Lockbits

The programmer has a dual function. In addition to being able to program a device out
of circuit using the applications module, you can also program a device which has been
soldered into your circuit. This allows you to solder in a blank device and program and
reprogram the device without removing it from the board. See the section on  Program-
ming In-system for details. Both methods use the same user software.

6.6 New Project This creates a new project. You will be prompted for the device type in a dialogue box.
Select the device you wish to base your project around, and press the OK Button.

The system will then open a Project Manager & Buffer windows to set project options
and allow you to Open the Program and EEPROM files.

6.7 Open Project Open Project allows you to open an existing project, and all associated files, and set-
tings.

Choose Open Project from the Project Menu or use the Speed Button.

6.8 Save Project It is available on the Project Menu & the toolbar.

This allows you to save your project options including font settings, window positions
and files in one quick, easy step.

You are prompted for a project file name .AVR extension and if either the Program or
EEPROM buffers have changed, you will be prompted to save them as well.

6.9 Load File This allows you to load a data file into your project. You must have the appropriate
buffer selected Program or EEPROM on top of the desktop when you choose Load File
in the File menu or click on the Load File button, as the file will be loaded into the cur-
rently open buffer.

The file loader currently has support for loading the following file types:

n Binary

n Intel Hex

n Motorola S Record

n Atmel Generic

The file type is automatically selected and requires no user intervention.

6.10 Save File This allows you to save a data file without saving the whole project. You must have the
appropriate buffer selected when you select Save File or Save File As, as the file in the
selected buffer will be saved.

The Save File option currently has support for saving the data in the following file types:

n Binary
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n Intel Hex

n Atmel Generic

To select the file type you want, select the file type from the save file as type pull down
box below the File name list in the Save File dialogue box.

6.11 Exit This will make the application close down. If you have recently made any changes to a
project, you will be prompted to save your project.

You can exit the program by using the speed button, clicking the close icon on the pro-
gram window X or choosing Project-Exit.

6.12 Clear Buffer It is available on the Buffer menu.

This will cause the currently selected buffer to be cleared, i.e. Filled with FF’s. Any data
currently in the buffer will be lost. Only the selected buffer will be cleared.

6.13 Fill Buffer It is available on the Buffer menu.

A small dialogue box appears where you can select the start address Fill From, the end
address Fill To and the value to insert Fill With. The new value is inserted in all the
selected addresses and is shown as green text.

6.14 Goto It is available on the Buffer menu.

This will cause the cursor to move to the location in the buffer specified. If the selected
value is larger than the buffer size, you are informed.

Note: The buffer size changes depending on the device selected.

6.15 Find It is available on the Buffer menu.

Find is used to search for a hex value in the buffer.

Simply enter the Hex Value you wish to find in the small dialogue box and hit the Find
First button. If the value is found the cursor will be moved to that location and you will
also notice that the ‘Find First’ button has now changed to ‘Find Next’. You can use this
to repeat your search and find the next occurrence.

Click the mouse on Done (or use tab and enter keys) to close the Find dialogue box.

6.16 Device Empty 
Check

Device Empty Check is a programming function.

It is available on the Program menu.

This checks to see that the device is blank, i.e. all locations contain FF.

Note: This function is only really useful when working with One-Time Programmable 
Devices (OTP) or UV Erasable Devices. It has no real use with the Atmel Flash 
Range, but provides a quick and easy way to check if a device is blank.

6.17 Program Device Program Device is a programming function.

It is available on the Program menu, or on the above button on the speed bar. On the
speed bar, it will program the current buffer into the appropriate memory space in the
device—Code or EEPROM data depending on which window is currently Focused.

This option Programs & Verifies each location, from the selected buffer window into the
appropriate location in the device.
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Note: It is advisable to erase the device before programming unless you are adding 
extra data to existing data in the device. If you are changing data then you can-
not change any programmed bit from a 0 to a 1 without erasing the device first. 
You can however change a bit from a 1 to a 0. So BB could be changed to AA 
for example but AA cannot be changed to BB. You will not be able to program 
the device if the write lockbit has been set.
If this function is selected from the Program Menu, it will only program the PRO-
GRAM MEMORY. In devices which also have EEPROM MEMORY available, 
you must use the PROGRAM EEPROM command.

The Program Device speed button will carry out either the PROGRAM MEMORY or
PROGRAM EEPROM command, depending on which buffer is on top of the desktop.

6.18 Verify Device Verify device is a programming function.

It is available on the Program menu, or on the above button on the speed bar.

This Verifies each location in the program memory buffer window with the appropriate
location in the device.

Note: This function will only verify the PROGRAM MEMORY.   In devices that also 
have EEPROM MEMORY available, you must use the VERIFY EEPROM com-
mand.

The Speed button will either Verify the Program or EEPROM memory, depending on
which buffer is currently selected.

6.19 Program 
EEPROM

Program EEPROM is a programming function.

It is available on the program menu, or on the above button on the speed bar. The
speed button will program the current buffer into the appropriate memory space in the
device, depending on which window is currently Focused.

This Programs & Verifies each location, in the EEPROM memory buffer window into the
appropriate location in the device.

Note: As the EEPROM features an auto-erase function, it does not require a chip- 
erase to be performed prior to programming. A chip-erase is only required if the 
lock bits are set.

The Speed button will either Program the Code or EEPROM memory, depending on
which buffer is currently selected. 

6.20 Verify EEPROM Verify EEPROM is a programming function.

It is available on the Program menu, or on the above button on the speed bar.

This Verifies each location, in the EEPROM buffer window with the appropriate location
in the device.

The EEPROM buffer must be selected on top if the Speed button is used. 

6.21 Read Device Read Device is a programming function.

It is available on the Program menu, or on the above button on the speed bar.
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This will Read each location in the Device into the appropriate location in the program
memory buffer window.

Note: This will overwrite any existing data in the buffer, and this will also not read 
EEPROM MEMORY unless the speed button is used with the EEPROM data 
window selected.

6.22 Read EEPROM Read EEPROM is a programming function.

It is available on the Program menu, or on the above button on the speed bar.

This will Read each EEPROM location in the Device into the appropriate location in the
EEPROM memory buffer window.

Note: This will overwrite any existing data in the EEPROM memory buffer window. 

If the speed button is used, the EEPROM data window must be on top of the desktop. 

6.23 Program 
Lockbits

Program Lockbits is a programming function.

 
It is available on the Program menu, or on the above button on the speed bar.

It will program the security lock bits according to the setting you have selected in the
Project Manager. 

Warning: Setting Lockbits may mean that you will be unable to perform further verifica-
tion on the device, and disable further writing to the device. However, you will be able to
re-use the device if you perform an erase. 

6.24 Erase Device Erase Device is a programming function.

It is available on the Program menu, or on the above button on the speed bar.

This will erase all data from the Program Memory & EEPROM Memory if available on
the device.

It is advisable to always erase a device before programming.

Warning: Erasing a device will clear all data from the device permanently.

6.25 Health Check Health Check is a programming function.

This unique function will check the device to see if it has any defects, which may prevent
it from programming correctly. So, for example, you can use it to test an old device to
see if it still works. This function also has an associated button on the toolbar. Note that
this function will erase any data that is currently on the device.

It will report a Pass or Failure. 

6.26 Printer Port This allows you to set which printer port the programmer is currently connected to.

Simply select the appropriate printer port, and hit the Change Button.

To Cancel any changes you have made press the Cancel button.

6.27 Font Selection This allows you to set a different Font for the Buffer Windows. You may wish to do this if
you feel that the default font is a little small, or unclear. The default font is Terminal, size
10, which is set for 14 inch monitors and is probably too small for larger monitors.



How to Use the Software

 13

As a rule of thumb, Terminal font is usually best for displaying the full ASCII character
set, as it has all the characters below 20. You will find other fonts will ‘fill’ these charac-
ters with a circumflexed Y or another similar character.

6.28 Advanced 
Options

This allows you to override Signature Byte Checking.

This is useful if you use pre-production devices which may not have signature informa-
tion included, or you are using an unsupported device which has the same programming
algorithm. USE WITH CARE. 

6.29 Edit as ASCII This option allows you to change the editing mode from Hex to ASCII and back. This is
useful if a mouse or pointing device is not available.

6.30 Device 
Checksum

Reads Device and calculates the check sum. It does not load the buffer with the device
contents.

6.31 Select Colors This allows you to change the color of the text in the buffer windows.

The 5 text modes and their default colors are:

The default colors can be changed selecting the data type you wish to change in the
‘Data Type’ list, and clicking on the change color button.

6.32 SPI Optimization The SPI optimization option located under the ‘Options’ menu allows you to improve the
performance of operations on AT89S SPI devices. By setting the option to ‘Auto’, you
may notice a significant performance increase, especially on lower spec PC systems
(i.e. below Pentium class).

Note: The default for this option is OFF. If you switch it to Auto and experience prob-
lems reading or programming a device, return the setting to ‘None’.

Text Mode Default Color

Blank Black

Load Data Blue

Edited Data Blue

Verified Data Green

Program/Verify failure Red
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Section 7

Programming Using the Board

7.1 Device 
Orientation

Before programming a device using the programming module, the device adapter must
be inserted correctly into the programming unit. The adapter itself has a corner cut off,
which locates pin 1 of the device and matches the marking on the main unit. This
adapter should be pre-fitted, but can be replaced if the device programming life is
exceeded—refer to your supplier to obtain new device adapter.

The orientation of the device is vitally important. If you put it in the wrong way then you
may damage the device. DO NOT PLUG A DEVICE ADAPTER IN WITH THE POWER
SWITCHED ON or you may damage it. Similarly never remove the device adapter with
the power on.

7.2 Voltage 
Selection

Jumper JP1 is used to select either 3.3V or 5V programming. 

For VCC = 5V remove jumper JP1 - jumper open

For VCC = 3.3V insert JP1 - jumper closed

Jumper JP2 is used to set Brown-out detector voltage.

For Brown Out = 4.5V insert jumper JP2 - jumper closed

For Brown Out = 2.9V remove jumper JP2 - jumper open

This should be set to the same voltage as VCC. If VCC is set to 3.3V and Brown-out is set
to 4.5V, then the device will be held in reset and will NOT program. See section on
Brown-out Detector for more details.
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7.3 Power and Lead 
Connections

The 10-way programming lead is inserted in the box header—the key-way ensures cor-
rect orientation. The computer connections are shown in the section on Connecting the
System.

The power supply 9-15V DC or 7-12V AC is plugged into the power connector 5.5/2.1
Barrel.

The Power On/Off switch is located next to the power connector. Insert the device
adapter before switching the power on. The power on LED should light when the power
is correctly applied.

Your hardware is now ready for programming. Refer to Using the Software description
for details of programming operations. A programming LED indicates programming is
happening.
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Section 8

Brown Out Detector

The brown out detector circuit is used to detect voltage drops. If a short glitch occurs in
the power, this circuit ensures that the processor resets properly rather than operating
randomly.

The brown out detector must be set to the same voltage as the circuit voltage, VCC—
3.3V or 5V. For 3.3V operation, jumper JP2 must be removed (jumper open) and for 5V
operation it must be closed.

These values are approximate and may vary with temperature and other factors.

Voltage Operating Voltage Hysteresis

5 Volts 4.5 Volts 200 mV

3.3 Volts 2.9 Volts 200 mV



 17

Section 9

Board Applications

9.1 Using Switches 
and LEDs

The LEDs are connected through a 1K resistor network to Port B.

The switches are connected to Port D.

The switches and LEDs can be disconnected if required, so to use them, ensure that the
jumpers labeled Port B and Port D are closed. The board is also marked with the port
pin connection for each switch and LED.

The ports must be correctly set in software as input or output. This is accomplished by
setting the direction control registers to 0 for input and 1 for output. Typical set up code
would be:

mov r16,$ff ;move literal into temporary store register

out DDRB,r16 ;set direction register to ones for output - LEDs

out PORTB,r16 ;switch all the LEDs on

mov r16,$00 ;move literal into temporary store register

out DDRD,r16 ;set direction register to zeros for input - 

Switches

9.2 Using External 
Connections

All the ports are brought out to headers on the edge of the board. In addition to the port
pins, each header has a connection for ground and VCC to supply external circuits. Note
this voltage, VCC, will be either 3.3V or 5V depending on the setting of jumper 1, JP1,
and the brown out detector will operate.

Note: If your circuit is to draw significant current (>150 mA) then a heat sink will be 
required on the on-board regulator—LM317. This device is rated at 1.5 Amps 
but it does need a heat sink to supply this current. If your circuit will draw more 
than 1 amp, you may need a separate power supply. The ports on the device 
are connected to the headers marked Port A, Port B, Port C, Port D, Port E and 
Analog, Port F. The layout of all the headers is the same and is shown in the fol-
lowing diagram.
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9.2.1 Misc. Header The last header labeled Misc. has connections to processor pins other than the port
pins.  

If external operations do not want pull-ups on the port pin, both the switches and the
LEDs can be disconnected from the processor. To isolate the LEDs, remove the jumper
set labeled Port B, and to isolate the switches, remove the jumper set labeled Port D.

9.3 Using Analog 
Functions

The A/D converters use the header labeled Analog for the A/D inputs on Port F, which is
input only. A +10V to -10V supply is provided on the connector marked Op-Amp next to
the crystal. A lead from this connector can be used for an external amplifier for the A/D
inputs. The layout of the Analog header is shown below.

9.3.1 Analog Port: 
Marked on Board

The A/D converters can use either the on-board (Internal) Voltage Reference or an
external Voltage Reference.

9.3.2 Using Internal 
Reference

To use the internal, on-board Voltage Reference, the pot marked AREF is used to set
the voltage level. The voltage level can be measured with a DVM connected to the

BIT 7 OF PORT.
SAME FOR ALL PORTS

EXTRA CONNECTION
FOR VCC

CUT CORNER
SHOWN ON BOARD
FOR ORIENTATION

BIT 0 OF PORT.
SAME FOR ALL PORTS

EXTRA CONNECTION
FOR GROUND

EXTRA CONNECTION
FOR VCC

CUT OUT MARKED
 ON BOARD

FOR ORIENTATION

EXTRA CONNECTION
FOR GROUND

READ
RD

WRITE
WR

CUT OUT MARKED
 ON BOARD

FOR ORIENTATION

ADC0 - ADC7 CONNECTED 
TO PORT FPF0 - PF7
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header pins labeled Analog Ref and Analog Gnd in the above diagram or from the two
holes marked Meter + and -.

9.3.3 Using External
Reference

To use the A/D converters with an external Voltage Reference, the link marked LK1
must be cut. The voltage is applied to the pins marked Analog Ref and Analog Gnd on
the Analog header—see diagram above. 

9.4 Using External 
RAM

The ATmega103 can be used with external SRAM. A socket is provided for a 28-pin
RAM chip and for an address latch chip. These are next to the device adapter at the top
of the board. There is also a header for further memory expansion, which is connected
through the address latch. The pin functions are marked on the board, including chip
select (CS).

9.4.1 RAM 
Recommendations 

A low power 62256 SRAM is suggested with an access time of 70 nS. If a very fast RAM
is required, the crystal frequency may need to be increased. If a much slower SRAM is
used, the SRAM Wait State bit must be enabled in user software–—see data book. The
layout of the 28-pin RAM socket is shown below, and any RAM with this pin-out could be
used.

9.4.2 RAM Socket Pin
Layout

9.4.3 Address Latch The board connections are for a 74HC573 device. This device will operate reliably with
the 4 MHz crystal supplied but if a faster crystal is inserted, a faster version of this
device may be required—74AHC573 or 74FHC573. Note that this option will alter the
EMC characteristics of the board and the CE mark will no longer be valid without re-test-
ing.

1
2
3
4
5
6
7
8
9
10
11
12
13
14

28
27
26
25
24
23
22
21
20
19
18
17
16
15

A14
A12

A7
A6
A5
A4
A3
A2
A1
A0

I/O0
I/O1
I/O2
VSS

VCC
WE
A13
A8
A9
A11
OE
A10
CS
I/O7
I/O6
I/O5
I/O4
I/O3
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9.5 Using LCD 
Connections

The header marked LCD interface is for a standard 2 x 16 LCD. The connections are
shown on the board and in the following table.

The board is designed for use with an LCD with a Hitachi driver chip built-in, with a con-
trast pin voltage of 0 to 5 Volts. The pot next to the LCD connector is used for contrast
adjustment.

If you use a different LCD driver, it may have a different voltage contrast range. In order
to accommodate this, add a resistor to the board (shown on board) and cut track on
underside of board—marked cut.

This board is not designed for use with back lit LCD modules, so the extra connections
needed are not included and the power supply will not supply the current required.

The LCD must be driven in Memory Mapped Mode as Read and Write are descite pins
on the Mega parts—see data sheet. If the crystal has been changed to a faster crystal
frequency, memory mapped operations will not work.

9.6 Using RS232 The connection supplied is a 9-way female D-type, so a straight through lead is
required—not a null-modem cable.

The Jumpers in the middle of the board, marked PE0 and PE1 must be set to RS232 not
Port or RXD and TXD will be disabled. 

As this board has a 4 MHz crystal, the percentage error on the Baud Rate will be
between 0.2 and 7.8%. Replacing the crystal with a 3.6846 MHz or 4.608 MHz crystal
will reduce this error to zero but may have EMC implications.

A standard (straight through) lead is required, NOT a null-modem cable.

9.7 Programming In-
System

Devices can be programmed in your circuit rather than on the board.

For In-System Programming, ISP, the 10-conductor ribbon cable is connected to a dual
row 10-pin 0.1" pitch header on your circuit.

You will need to use either a multiplexer chip, such as a 4053, or wire directly to the Pins
of the device. Without a multiplexer chip, Serial Communications and SPI port will be
unusable.

Connection Name Function

0V Ground

+5 VCC - must be 5V

Vo Contrast

RS Register Select- A14

Wr Not Write 

E Enable

D0 Data Bit 0

D1 Data Bit 1

D2 Data Bit 2

D3 Data Bit 3

D4 Data Bit 4

D5 Data Bit 5

D6 Data Bit 6

D7 Data Bit 7
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In addition the system 5 Volts and Ground need to be connected to the programming
lead.

DO NOT EXCEED 5 VOLTS ±5% (4.75V TO 5.25V). YOU MAY DAMAGE YOUR COM-
PUTER.   THIS WARNING APPLIES TO ANY ISP SYSTEM. BEWARE!!!

9.8 ISP Header 
Layout

9.9 Interface Using 
Resistors  

Typical resistor values would be 1K. This circuit is fine if ports PB7, PE0 and PE1 are
used as inputs in your circuit and no communication is required. If Outputs are needed
or RS232 connections, especially higher than a few milliamps, then the multiplexed cir-
cuit is preferable.

9.10 Using an 
Analogue 
Multiplexer IC 

KEY WAY

OPTIONAL PROGRAM
INDICATOR CICRUIT

PROGRAMMING HEADER MISO IS CALLED PDO AND
MOSI IS PDI ON MEGA
DEVICES - PORT E BITS 0 AND 1
NOT PINS ON PORT B.

USER
CIRCUIT

TO ISP
CONNECTOR

TO USER
CIRCUIT
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The multiplexer select can be driven from the LED connection on the programming lead
so can a low power LED with its cathode connected to the LED connection via a suitable
resistor—1KΩ is fine. If you use this connection then the output will be low 0 during pro-
gramming and a 1 at all other times.   Note that it will float if the programmer is not
active, i.e. the software is not running, so you may need to use a pull-up resistor.

Note: All the pins except ground will float if the programmer is not active. The device 
may then be programmed in the normal way.

9.10.1 Using Real Time 
Clock

A 32.768 kHz crystal is connected to TOSC1 and TOSC2 pins—Pin 18 and Pin 19. This
can be used to generate a 1 second pulse—see data book for details.
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Sectio n 10

Technical Support

Technical support for this product is provided by the AVR Starter Kit Support Team. Con-
tact information is provided below.

10.1 Contact Info We would be grateful if you can pass on any errors you may find in this software. We
pride ourselves on our customer support and we can solve the problem and send you an
update very quickly via e-mail. If you wish to communicate via telephone the number is
listed below: 

Tel: (44) 1970 621 049 STK300 Technical Support Hotline

Fax: (44) 1970 621 040

e-mail: stk 300_support@atmel.com

Website: www.atmel.com

We also have an extensive range of AVR development products available. Please visit
our website (http://www.atmel.com) for full details.

Software upgrades will be made available on our website.

10.2 Warranty  Atmel warrants that the Product delivered hereunder shall conform to the applicable
Atmel Data Sheet or mutually agreed upon specifications and shall be free from defects
in material and workmanship under normal use and service for a period of 30 days from
the applicable date of invoice.  Products which are "samples", "design verification units",
and/or "prototypes" are sold "AS IS," "WITH ALL FAULTS," and with no warranty what-
soever.

If, during such warranty period, (i) Atmel is notified promptly in writing upon discovery of
any defect in the goods, including a detailed description of such defect; (ii) such goods
are returned to Atmel, DDP Atmel's facility accompanied by Atmel's Returned Material
Authorization form; and (iii) Atmel's examination of such goods discloses to Atmel's sat-
isfaction that such goods are defective and such defects are not caused by accident,
abuse, misuse, neglect, alteration, improper installation, repair, improper testing, or use
contrary to any instructions issued by Atmel, Atmel shall (at its sole option) either repair,
replace, or credit Buyer the purchase price of such goods.  No goods may be returned to
Atmel without Atmel's Returned Material Authorization form.

Prior to any return of goods by Buyer pursuant to this Section, Buyer shall afford Atmel
the opportunity to inspect such goods at Buyer's location, and any such goods so
inspected shall not be returned to Atmel without its prior written consent.

Atmel shall return any goods repaired or replaced under this warranty to Buyer transpor-
tation prepaid, and reimburse Buyer for the transportation charges paid by Buyer for
such goods.  The performance of this warranty does not extend the warranty period for
any goods beyond that period applicable to the goods originally delivered.



Technical Support

24  

THE FOREGOING WARRANTY CONSTITUTES ATMEL'S EXCLUSIVE LIABILITY,
AND THE EXCLUSIVE REMEDY OF BUYER, FOR ANY BREACH OF ANY WAR-
RANTY OR OTHER NONCONFORMITY OF THE GOODS COVERED BY THIS
AGREEMENT.  THIS WARRANTY IS EXCLUSIVE, AND IN LIEU OF ALL OTHER
WARRANTIES. ATMEL MAKES NO OTHER WARRANTIES, EXPRESS, IMPLIED, OR
STATUTORY, INCLUDING WITHOUT LIMITATION ANY WARRANTIES OF MER-
CHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.  THE SOLE AND
EXCLUSIVE REMEDY FOR ANY BREACH OF THIS WARRANTY SHALL BE AS
EXPRESSLY PROVIDED HEREIN.

LIMITATION ON LIABILITY

Notwithstanding anything to the contrary contained herein, Atmel shall not, under any
circumstances, be liable to Buyer or any third parties for consequential, incidental, indi-
rect, exemplary, special, or other damages.  Atmel's total liability shall not exceed the
total amount paid by Buyer to Atmel hereunder.  Atmel shall not under any circum-
stances be liable for excess costs of reprocurement.
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Appen dix I

Corporate Headquarters
2325 Orchard Parkway
San Jose, CA 95131
TEL (408) 441-0311
FAX (408) 487-2600

Europe
Atmel U.K., Ltd.
Coliseum Business Centre
Riverside Way
Camberley, Surrey GU15 3YL
England
TEL (44) 1276-686677
FAX (44) 1276-686697

Asia
Atmel Asia, Ltd.
Room 1219
Chinachem Golden Plaza
77 Mody Road
Tsimshatsui East
Kowloon, Hong Kong
TEL (852) 27219778
FAX (852) 27221369

Japan
Atmel Japan K.K.
Tonetsu Shinkawa Bldg., 9F
1-24-8 Shinkawa
Chuo-ku, Tokyo 104-0033
Japan
TEL (81) 3-3523-3551
FAX (81) 3-3523-7581


